
Zistite viac

Škoda Fabia Drive
CenCenník (platnník (platný od 01.01.2025 s DPH 23%)ý od 01.01.2025 s DPH 23%)

Akčný model Škoda Fabia Drive nie je možné kombinovať s veľkoodberateľskými podmienkami. Bližšie informácie získate u
participujúcich autorizovaných partnerov značky Škoda.

Fabia Drive

Motor PalivPalivoo PrPreevvodoodovkavka PohonPohon Základná cena Bonus Akciová cena **

1.0 MPI 59 kW (80 k) Benzín 5° MP predný 16 510 -1-1 750750 14 760
1.0 TSI 70 kW (95 k) Benzín 5° MP predný 17 250 -1-1 650650 15 600
1.0 TSI 85 kW (116 k) Benzín 6° MP predný 17 650 -1-1 650650 16 000

Fabia Drive Plus

Motor PalivPalivoo PrPreevvodoodovkavka PohonPohon Základná cena Bonus Akciová cena **

1.0 MPI 59 kW (80 k) Benzín 5° MP predný 17 260 -1-1 650650 15 610
1.0 TSI 70 kW (95 k) Benzín 5° MP predný 17 970 -1-1 650650 16 320
1.0 TSI 85 kW (116 k) Benzín 6° MP predný 18 370 -1-1 650650 16 720
1.0 TSI 85 kW (116 k) Benzín 7° AP DSG predný 19 910 -1-1 650650 18 260
1.5 TSI 110 kW (150 k) Benzín 7° AP DSG predný 21 600 -1-1 650650 19 950

** Najnižšie ceny príslušných motorových vozidiel za posledných 30 dní vám poskytujeme v zmysle zákona č. 108/2024 Z.z. o ochrane spotrebiteľa
a sú dostupné na internetovej stránke www.skoda.sk/ceny.
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Prečo práve Fabia Drive?

Fabia Drive

O váš komfort sa postará výškovo nastaviteľné sedadlo vodiča,
praktická stredová konzola a predná lakťová opierka s odkladacou
schránkou Jumbo Box. Jazdu si však užijú aj ostatní; vďaka tkaným
kobercom a doplnkovým reproduktorom vzadu. O konektivitu sa
postará bezdrôtový Smartlink.

Ešte viac s Drive Plus

K paketu Drive sme vám pridali ešte nejedno Plus: elektrické
ovládanie všetkých okien, parkovaciu kameru s ostrekovačom a
výškovo nastaviteľné predné sedadlá s bedrovými opierkami.
Atraktívny dizajn 15" zliatinových diskov Rotare padne do oka naozaj
každému (okrem 1,5 TSI).

S uvádzacím bonusom dostupnejšie

Rozhodnite sa pre nový akčný model Drive a my vám to
zjednodušíme. Využite našu ponuku a odrátajte si prislúchajúci Drive
bonus až do výšky 1 650 € z ceny vášho nového auta. Radi vám
pomôžeme s financovaním a zostavíme ideálny splátkový plán, ktorý
nezaťaží váš rozpočet.

5-ročná predĺžená záruka

S predĺženou zárukou získavate istotu, že vám počas 5 rokov od kúpy
vozidla (alebo do 100000 km) nevzniknú žiadne nepredvídané
náklady spojené s opravou vášho vozidla. Jazdite aj vy bez starostí.

Vyberte si svoj interiér

Loft Lodge

Suite Dynamic
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Základná výbava

Interiér Studio

Oceľové disky kolies 5,5J x 15" s krytmi Callisto (185/65 R15)

Airbag vodiča a spolujazdca, airbag spolujazdca s deaktiváciou

Hlavové airbagy a bočné airbagy vpredu

ESC vrátane ABS, MSR, ASR, EDS, HBA, XDS

Front Assist – výstraha pred kolíziou a podpora núdzového brzdenia
a Pederstrian Monitor (ochrana chodcov)

Lane Assist – asistent udržiavania v jazdnom pruhu

Driver Alert - asistent rozpoznania únavy

ISOFIX a Toptether pre sedadlo spolujazdca

8" virtuálny kokpit

Easy Light Assist – svetelný senzor

LED hlavné svetlomety + LED denné svietenie

Predné hmlové svetlomety

Kontrola tlaku v pneumatikách

Zadné parkovacie senzory

Zadné kotúčové brzdy (len pre 1.0 TSI 85kW )

Centrálne zamykanie s diaľkovým ovládaním (2 sklopné kľúče)

Infotainment Škoda s 8" dotykovým displejom

2x USB-C vpredu

DAB – digitálny rádiopríjem

Bluetooth

6 reproduktorov

Bedrôtový Smartlink

Čítanie dopravných značiek

Výškovo nastaviteľné sedadlo vodiča

Elektricky nastaviteľné a vyhrievané vonkajšie spätné zrkadlá,
lakované vo farbe karosérie

Lakťová opierka vpredu

Manuálna klimatizácia

Elektrické ovládanie okien vpredu

2-ramenný PUR volant

Obmedzovač rýchlosti

Vkladané tkané koberce vpredu a vzadu

Funkčný paket: 3 stropné madlá (zadné s háčikmi), slnečné clony
s Make-up zrkadlom na strane vodiča a spolujazdca, schránka
na okuliare, lampičky na čítanie vpredu a vzadu

3. hlavová opierka vzadu

Zadné sedadlá nedelené, zadné operadlá delené a sklopné v pomere
60:40

Tyre Fit – súprava na opravu pneumatík

e-Call - tiesňové volanie

Proaktívny servis na 10 rokov

Predĺžená záruka na 5 rokov/100 000 km
(Platí tá z podmienok, ktorá nastane skôr, prvé 2 roky bez
obmedzenia počtu kilometrov)

Premenlivý servisný interval s výmenou oleja až 30 000 km alebo
každé 2 roky

Škoda – Doživotná Garancia Mobility Premium
Poskytuje pomoc servisným vozidlom na mieste poruchy (porucha
na vozidle, chýbajúce PHM, defekt pneumatiky, zabuchnuté/stratené
kľúče, vybitá batéria, zámena paliva), odtiahnutie vozidla, prípadne
služby – náhradnú dopravu, požičanie náhradného vozidla,
ubytovanie pre posádku a i.

Interiér Loft

Disky z ľahkej zliatiny Rotare Aero 5,5J x 15" - strieborné (okrem
1.5 TSI 110 kW)

Disky z ľahkej zliatiny Proxima 6J × 16" – strieborné (iba
pre 1.5 TSI 110 kW)

Full LED zadné svetlá

Zadná parkovacia kamera

Zadné kotúčové brzdy (len pre 1.0 TSI 85 kW a 1.5 TSI 110 kW)

Asistent rozjazdu do kopca

Elektrické ovládanie okien vzadu

Výškovo nastaviteľné predné sedadlá s manuálne nastaviteľnými
bedrovými opierkami

Easy Start - centrálne zamykanie s diaľkovým ovládaním
a štartovaním tlačidlom

2-ramenný kožený multifunkčný volant

Tempomat s obmedzovačom rýchlosti

Úložné vrecká na zadnej strane operadiel predných sedadiel

Dáždnik vo výplni dverí vodiča

Drive

Drive Plus (navyše oproti Drive)
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Doplnková výbava

Assisted Drive › Adaptive Lane Assist
› Adaptívny tempomat do rýchlosti 210 km/h

(nie je možné pre 1.0 MPI 59 kW)

PUE − 424

Assisted Drive Plus › Naviac oproti Assisted Drive
› Side Assist
› Vnútorné spätné zrkadlo s automatickým stmavovaním
› Elektricky nastaviteľné, vyhrievané a sklopné vonkajšie

spätné zrkadlá s automatickým stmievaním na strane
vodiča

› Light and Rain Assist - svetelný a dažďový senzor
› Predné hmlové svetlomety s funkciou corner

(nie je možné pre 1.0 MPI 59 kW)

PUF − 1072

Assisted Drive Premium › Navyše oproti Assisted Drive Plus:
› Full LED predné svetlomety s LED denným svietením

a LED corner funkciou
(nie je možné pre 1.0 MPI 59 kW)

PU3 − 1670

Light & View › Vnútorné spätné zrkadlo s automatickým stmavovaním
› Elektricky nastaviteľné, vyhrievané a sklopné vonkajšie

spätné zrkadlá s automatickým stmievaním na strane
vodiča

› Light and Rain Assist - svetelný a dažďový senzor
› Predné hmlové svetlomety s funkciou corner

PUM − 376

Light & View Plus › Naviac oproti Light & View:
› Full LED predné svetlomety s LED denným svietením

a LED Corner funkciou
› Predné hmlové svetlomety bez funkcie corner

PUN − 1016

Safety Pack › Kolenný airbag
› Bočné airbagy vzadu

PE4 478 478

Asistent rozjadu do kopca UG1 85 •

Transport › Cargo Elementy
› Multifunkčná kapsa pod zadným platom
› Sieťový program
› Obojstranný koberec v batožinovom priestore (guma/

látka)

PUP 113 113

Transport (pre dvojitú podlahu) › Cargo Elementy
› Multifunkčná kapsa pod zadným platom
› Sieťový program
› Obojstranný koberec v batožinovom priestore (guma/

látka)
(možné len s 3GD)

PUQ − 97

Family › Odpadkový kôš
› Odkladací priestor s flexibilným držiakom na zadnom

tuneli
› Lakťová opierka vzadu
› Držiak na tablet

PUR − 140

Paket na zlé cesty (nie je možné pre motorizáciu 1.5 TSI 110 kW) PK4 203 203

Výsuvné integrované ostrekovače svetlometov, ukazovateľ hladiny kvapaliny v nádobe na ostrekovače PK5 165 165

Príprava pre ťažné zariadenie (nie je možné s WC2) PTX 120 120

Ťažné zariadenie – odnímateľné (nie je možné s WC2) PTZ − 545

Ťažné zariadenie – odnímateľné s adaptérom (nie je možné s WC2) PTY − 585

Fajčiarsky paket (popolník vpredu a zapaľovač) 9JD 30 30

Dvojitá podlaha v batožinovom priestore (iba s PUQ) 3GD − 153

Športový podvozok PSP − 148

Drive Drive PlusBezpečnosť

Drive Drive PlusFunkčnosť
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Lodge › Látkové sedadlá Lodge
› Ambietné osvetlenie prepínateľné biela/červená
› Poťah prístrojovej dosky Látka Nuba Grey s prešívaním
› Chrómové orámovanie výduchov ventilácie
› 4 LED lampičky na čítanie

WQ3 − 234

Suite › Látkové sedadlá Lodge
› Ambietné osvetlenie prepínateľné biela/červená
› Poťah prístrojovej dosky Látka Nuba Copper s prešívaním
› Chrómové orámovanie výduchov ventilácie
› 4 LED lampičky na čítanie

WQ6 − 234

Dynamic › Športové látkové sedadlá
› Poťah prístrojovej dosky Látka Dynamic
› Ozdobné kryty pedálov z ušľachtilej ocele
› Vkladané tkané koberce vpredu a vzadu
› 3-ramenný športový kožený multifunkčný volant
› Chrómové orámovanie výduchov ventilácie

WQ8 − 372

2-ramenný kožený multifunkčný volant PLB 399 •

2-ramenný kožený multifunkčný volant s ovládaním DSG prevodovky PLC − 104

2-ramenný vyhrievaný kožený multifunkčný volant (možné len s PHB/PUH/PUI) PLD − 109

2-ramenný vyhrievaný kožený multifunkčný volant s ovládaním DSG prevodovky (možné len s PHB/PUH/
PUI)

PLE − 188

3-ramenný športový kožený multifunkčný volant PLF − 99

3-ramenný športový kožený multifunkčný volant s ovládaním DSG prevodovky PLG − 234

3-ramenný športový vyhrievaný kožený multifunkčný volant (možné len s PHB/PUH/PUI) PLH − 208

3-ramenný športový vyhrievaný kožený multifunkčný volant s ovládaním DSG prevodovky (možné len
s PHB/PUH/PUI)

PLI − 287

Disky z ľahkej zliatiny Rotare Aero 5,5J x 15" - strieborné (pneu 185/65 R15) PJ2 627 •

Disky z ľahkej zliatiny Rotare Aero 5,5J x 15" - čierne lesklé (pneu 185/65 R15) PJ3 − 116

Disky z ľahkej zliatiny Proxima 6J x 16" - strieborné (pneu 195/55 R16)
(cena okrem 1.5 TSI 110 kW /pre 1.5 TSI 110 kW)

PJ4 − 483/ •

Disky z ľahkej zliatiny Proxima 6J x 16" s Aero krytmi - čierne lesklé (pneu 195/55 R16)
(cena okrem 1.5 TSI 110 kW /pre 1.5 TSI 110 kW)

PJ5 − 657 / 174

Disky z ľahkej zliatiny Proxima 6J x 16" s Aero krytmi - sivé (pneu 195/55 R16)
(cena okrem 1.5 TSI 110 kW /pre 1.5 TSI 110 kW)

PJ6 − 657 / 174

Rezervné koleso (neplnohodnotné) pre 15" disky + zdvihák +klúč na kolesá PJA 135 135

Rezervné koleso (dojazdové) pre 16", 17" a 18" disky + zdvihák +klúč na kolesá PJB 135 135

Park&Go › Drive Mode Select
› KESSY - bezkľúčové odomykanie, zamykanie

a štartovanie
› Predné parkovacie senzory

(nie je možné pre 1.0 MPI 59 kW)

PUA − 427

Park & Go Plus › Naviac oproti Park & Go:
› Park Assist – parkovací asistent

(nie je možné pre 1.0 MPI 59 kW)

PUC − 544

Park & Go (So Safe Systémom a Alarmom) › Drive Mode Select
› KESSY - bezkľúčové odomykanie, zamykanie

a štartovanie so Safe Systémom
› Alarm
› Predné parkovacie senzory

(nie je možné pre 1.0 MPI 59 kW)

PUB − 593

Park & Go Plus (So Safe Systémom
a Alarmom)

› Naviac oproti Park & Go (So Safe Systémom
a Alarmom):

› Park Assist – parkovací asistent
(nie je možné pre 1.0 MPI 59 kW)

PUD − 682

Drive Drive PlusVolanty / interiéry / sedadlá

Drive Drive PlusDisky / pneumatiky

Drive Drive PlusKomfort
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Vyhrievané predné sedadlá 4A3 283 283

Winter Plus › Vyhrievané predné sedadlá
› Ukazovateľ stavu kvapaliny v ostrekovači
› Climatronic – dvojzónová automatická klimatizácia so

senzorom vlhkosti a kombi filtrom
› Vnútorné spätné zrkadlo s automatickým stmavovaním

(iba s PLD, PLE, PLH, PLI)

PUH − 503

Winter Premium › Naviac oproti Winter Plus:
› Vyhrievané čelné sklo

(iba s PLD, PLE, PLH, PLI)

PUI − 613

Chrome › Sunset – sklá s vyšším stupňom tónovania od B‑stĺpika
› Podokenná chrómová lišta
› Nástupné prahové lišty na prahoch dverí

PUJ − 253

Parkovacie senzory vpredu 7X2 − 351

Tempomat s obmedzovačom rýchlosti 8T6 165 •

Adaptive Cruise Control – adaptívny tempomat do 210 km/h (nie je možné pre 1.0 MPI 59 kW) PL2 − 313

SUNSET – sklá s vyšším stupňom tónovania od B‑stĺpika 4KF − 165

Climatronic – dvojzónová automatická klimatizácia so senzorom vlhkosti a kombi filtrom PHB − 396

Operadlo predného sedadla spolujazdca sklopné do vodorovnej polohy (možné len s WQ3/WQ6) 3H2 − 99

Navi paket › Škoda Navigation s 9,2" dotykovým displejom
› Virtuálny kokpit – 10" digitálny prístrojový panel

s nastaviteľným zobrazovaním údajov
› Hlasové ovládanie
› Care Connect + Infotainment online služby na 3 roky

WNA − 1293

Charging › Phonebox
› 2 x USB-C vzadu so zvýšeným nabíjacím výkonom
› USB-C v držiaku vnútorného spätného zrkadla

PU2 − 299

10" Virtuálny kokpit – digitálny prístrojový panel s nastaviteľným zobrazovaním údajov 9S0 − 474

Sound Systém Škoda - Škoda Soundpaket so 6 reproduktormi a subwoofer, rezervné koleso (dojazdové)
pre Sound Systém zdvihák +klúč na kolesá (možné iba s WNA)

PJC − 644

Alarm (PD1 platí pre Drive, PD3 platí pre Drive Plus) PD1/PD3 261 261

KESSY- systém bezkľúčového odomykania, zamykania a štartovania s alarmom a systémom safe PD5 − 465

Modrá Energy *UNI 0 0

Biela Candy *SPE 359 359

Metalické farby *MET 539 539

Oranžová Phoenix, Červená Velvet *FLT 897 897

Color Concept Čierny (možné len s PJ5) -
nezahŕňa farbu vozidla

› Čierna strecha
› Čierne vonkajšie spätné zrkadlá
› Chrómované orámovanie prednej masky

WC1 − 244

Color Concept Sivý (možné len s PJ6, nie je
možné s PTX/PTY/PTZ) - nezahŕňa farbu
vozidla

› Sivá strecha
› Sivé vonkajšie spätné zrkadlá
› Sivé orámovanie prednej masky

WC2 − 258

Predĺžená záruka na 5 rokov/100 000 km EA4 • •

Predĺžená záruka na 5 rokov/150 000 km EA9 203 203

• Základná výbava − Nie je v ponuke MPManuálna prevodovka AP Automatická prevodovka

Drive Drive PlusKomfort

Drive Drive PlusMultimédiá

Drive Drive PlusZabezpečenie vozidla

Drive Drive PlusOstatné
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Ponuka farieb a diskov

Červená Velvet, metalická Modrá Race, metalická Oranžová Phoenix, metalická Biela Moon, metalická

Čierna Magic, metalická Sivá Graphite, metalická Modrá Energy, uni Biela Candy, uni

Strieborná Brilliant, metalická

Oceľové disky 15"
s krytmi Callisto

Rotare 15”
strieborné

Rotare 15”
čierne

Proxima 16”
strieborné

Proxima 16"
čierne lesklé
s aero krytmi

Proxima 16”
sivé

s aero krytmi
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Servis 5 rokov / 75 000 km 769 1513

Servis 5 rokov / 100 000 km 997 2128

Servis 5 rokov / 150 000 km 1476 3383

Basic ProfessionalServisné balíčky

Poznámky

Technické dáta vozidla nájdete v katalógu technických dát na stránke www.skoda-auto.sk.
Ceny uvedené v cenníku sú odporúčané ceny pre klienta v € vrátane DPH 23%.
Doplnková výbava znamená bohatšie vybavenie vozidla, nie zdvojenú výbavu. Konečnú cenu, výbavu a jej
možnú kombinovateľnosť konzultujte s autorizovaným predajcom značky Škoda.
Spoločnosť Škoda Auto Slovensko s. r. o. si vyhradzuje právo zmeny cien a špecifikácií
bez predchádzajúceho upozornenia. Všetky obrázky sú ilustračné.

Cenník platný od 01.01.2025 (MR2025)

Spoločnosť Škoda Auto sa usiluje o zodpovedný, trvale udržateľný vývoj spoločnosti a šetrný prístup k životu a prírode.

Váš autorizovaný partner značky Škoda
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